
Vernier Science Education • 888-VERNIER (888-837-6437)  

info@vernier.com • www.vernier.com 

CAST 2023 

Houston, TX 

Sparking Curiosity: Hands-on 

Experiments for Elementary 

Students 

Experiments 

How Do Mittens Keep You Warm?  

● Go Direct Temperature Probe 

e-Motion  

 Go Direct Motion Detector 

Exploring the Poles (Without Leaving Your Classroom!)  

 Go Direct 3-Axis Magnetic Field Sensor 

 

 

Workshop Presenters 

Dave Carter  

Colleen McDaniel 

support@vernier.com 

mailto:info@vernier.com
http://www.vernier.com/
mailto:techsupport@vernier.com




Name: ________________________________ 

Elementary Science with Vernier © Vernier Science Education  1 

  Graphical Analysis 2 

How Do Mittens Keep You Warm? 

Do you have a favorite pair of mittens or gloves? Even if you do not live in a cold place, it is 

possible that you have been somewhere cold or will go to a cold place when you are older. When 

you wear mittens or gloves to keep you warm, where do you think the warmth comes from? In this 

experiment, you are going to find the source of the heat.  

OBJECTIVES 

 Find the temperature of the classroom and the temperature of your hand. 

 Try to predict temperature changes that happen when the Temperature Probe is placed in 

various locations. 

 Test how warm mittens help your hands stay warm.  

MATERIALS 

Chromebook, computer, or mobile device 

Graphical Analysis app 

Go Direct Temperature 

mitten 

KEY QUESTION 

Do mittens make heat or hold heat in? 

HYPOTHESIS 

Choose one of the following by checking the box in front of the statement that you think is right. 

□  1. Mittens make their own heat. 

□  2. Mittens hold heat in. 

Why do you think so? 
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PROCEDURE 

1. Get the equipment ready for data collection: 

a. Launch Graphical Analysis.  

b. Connect the Temperature Probe to your Chromebook, computer, or mobile device.  

c. Put the Temperature Probe on the desk and don’t touch it until you are told to do so later 

on.  

2. Click or tap Mode to open Data Collection Settings. Set End Collection to 60 s. Click or tap 

Done.  

3. Do the following to find the temperature of the classroom: 

a. Make sure the Temperature Probe is lying on the desk and hasn’t been touched by anyone. 

If it has been lying there for a few minutes, it will be the temperature of the room. 

b. Look at the meter and write down the temperature as the Room temperature in the Data 

Table.  

Data Table Room temperature _____________ °C 

  
Prediction 

(°C) 
Maximum temperature  

(°C) 
Was your prediction 

high or low? 

Open hand      

Empty mitten      

Open hand in mitten      

  

4. Make a prediction:  

a. Think about what will happen to the temperature on the screen if you hold the probe across 

the palm of your open hand during data collection. Think about your body temperature 

compared to the room temperature.  

b. Guess how high the temperature will be at the end of data collection and write down your 

prediction in the Data Table.  

 

Figure 1    
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5. Now, collect data for the temperature of your open palm:  

a. Make sure the temperature values on the meter are very close to the value you recorded as 

the room temperature in your Data Table in Step 3. 

b. Click or tap Collect to start data collection. 

c. Place the tip of the metal part of the probe in the middle of your open palm, holding it by 

the black end with your other hand. Important: The tip of the probe should be gently 

touching your palm. Don’t close your fingers over the metal part.  

d. Hold the probe in the correct position during data collection. 

6. Do the following to find the maximum temperature of your open palm:  

a. Click or tap View, , and turn on Data Table. Dismiss the View menu. 

b. Look through the data table on the screen and find the maximum (largest) temperature 

value. 

c. Record this value in the correct place on the Data Table. 

7. After you have finished finding the temperature of your open palm, place the Temperature 

Probe on your table and allow it to sit there without being touched. This way, the probe will 

cool down to the temperature of the room. While it cools, continue with the next step. 

8. During this part of the experiment, you will place the Temperature Probe inside the mitten so 

you can measure the temperature inside the mitten. You will not have a hand inside the mitten, 

just the Temperature Probe. 

a. Think about what will happen to the temperature inside a mitten while it is sitting on the 

desk. The Temperature Probe will be inside the mitten but your hand will not be. 

b. Now, guess how high the temperature will be at the end of data collection and write down 

your prediction in the Data Table.  

c. Without touching the Temperature Probe, look at the temperature values in the digital 

meter on the screen. Make sure the temperature is very close to the value you recorded as 

the room temperature in your Data Table. If the temperature is not very close, wait until it 

is. 

d. Place the mitten on the table and slip the Temperature Probe into the mitten. Make sure 

you do not touch the metal part of the probe. 

e. Click or tap Collect to start data collection. Note: The first data set is automatically saved. 

f. When data collection is done, look through the data table on the screen.  

g. Find the maximum (largest) temperature value for the Latest data. Record this value in the 

correct place on the Data Table. 

h. Place the Temperature Probe on the table and allow it to sit there without being touched. 
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9. During this part of the experiment, you will measure the temperature of your hand inside the 

mitten. 

a. Think about what will happen to the temperature of your hand inside the mitten. 

b. Now, make a prediction about how high the temperature will be at the end of data 

collection and write down your prediction in the Data Table.  

c. Without touching the Temperature Probe, look at the temperature values in the digital 

meter on the screen. Make sure the temperature is very close to the value you recorded as 

the room temperature in your Data Table in Step 3. 

d. Place the mitten on your hand and slip the Temperature Probe into the mitten  

(see Figure 2). Position the tip of the probe in the middle of your palm. Leave your hand 

open during data collection, do not close your fist. 

e. Start data collection. 

f. When data collection is done, look through the data table on the screen.  

g. Find the maximum (largest) temperature value for the Latest data. Record this value in the 

correct place on the Data Table. 

 

Figure 2    

ANALYZE YOUR DATA 

1. What is the source of heat in this experiment? 

  

  

 

2. If the mitten does not produce heat on its own, then how do mittens keep your hands warm? 
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3. Thinking about the previous question, explain the difference between heat production and heat 

retention. 
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e-Motion 

Have you ever wondered how automatic doors at grocery stores know when to open? There is a 

sensor over the door that detects objects, such as a person walking up to the door.  

The Motion Detector that you will use in this activity can also do this. The Motion Detector works 

by sending out a signal and then measuring how long it takes for reflections to return to the sensor. 

Based on the amount of time it takes the signal to bounce back, the data-collection software is able 

to calculate the position of the object. 

 

Figure 1    

OBJECTIVES 

 Explore the different lines and curves produced by moving in front of the Motion Detector. 

 Learn to write detailed steps for creating an M or W shape on the graph. 

 Match different letter and designs drawn on the graph. 

MATERIALS 

Chromebook, computer, or mobile device 

Graphical Analysis app 

Go Direct Motion Detector 

PROCEDURE 

Part I  Creating straight-line letters such as M and W 

1. Set up the equipment for data collection:  

a. Launch Graphical Analysis. 

b. Connect the Motion Detector to your Chromebook, computer, or mobile device. 

c. Click or tap Mode to open Data Collection Settings. Set End Collection to 10 s. Click or 

tap Done. 

d. Click or tap View, , and choose 1 Graph. This will display a graph of position vs. time. 
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2. Set the Motion Detector on a table so that there is an open path at least 2 meters wide and 

3 meters long in front of it. You should face the sensor and must also be able to see the screen 

of your Chromebook, computer, or mobile device. 

3. Before you begin, review the different lines you can make using the Motion Detector. Draw 

lines to connect each graph to the directions that you would follow to make the line. 

 
   

    

Start 3 meters from the  

Motion Detector and move forward  

for 10 seconds moving slowly. 

 

    

Start 0.5 meters from the  

Motion Detector and move 

backward  

for 6 seconds moving quickly. 

 

    

Start 1 meter from the  

Motion Detector and move 

backward  

for 8 seconds moving slowly. 

 

    

Start 2 meters from the  

Motion Detector and move forward  

for 4 seconds moving quickly. 

 

    

Start 1 meter from the  

Motion Detector and  

stand still for 4 seconds. 

  

 

Figure 2    

4. In this part of the activity, you will write the steps that you will follow to create the letter M 

using a Motion Detector. An example of what the M might look like is shown in Figure 2. 
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Think about how you would make a similar M shape and fill in the blanks below. You will 

have a total of 10 seconds. 

a. Start _______ meters from the Motion Detector. 

b. Stand still for _______ second(s). 

c. Move ______________ (forward or backward) for _______ seconds moving 

__________ (quickly or slowly). 

d. Move ______________ (forward or backward) for _______ seconds moving 

__________ (quickly or slowly). 

e. Move ______________ (forward or backward) for _______ seconds moving 

__________ (quickly or slowly). 

f. Move ______________ (forward or backward) for _______ seconds moving 

__________ (quickly or slowly). 

g. Stand still for the last _______ second(s). 

5. Estimate the distance from the sensor needed to begin the M and then stand in front of the 

Motion Detector, facing it at that position. 

6. Have another person click or tap Collect to start data collection, and  follow the directions you 

wrote in Step 4. Note: Be sure to keep your hands at your sides and as still as possible. 

7. If the graph of the M looks like the example, congratulations! If you want to try to make the M 

again, just start data collection, and follow the directions you filled out. 

8. You will now make the letter N. Think about how you would move to make the N: 

 

Figure 3    
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9. Write down the steps you would take to match the letter N. Use the words in Step 4 as a 

pattern. 

  

  

  

  

  

10. Have one student stand in the right place in front of the Motion Detector. Have another student 

click or tap Collect to start data collection, and then follow the directions you wrote in Step 9 

for making the letter N.  

11. If the graph of the N looks like the example, congratulations! If you want to try to make the N 

again, just start data collection, and follow the directions you wrote. 

12. You will now make the letter W. Think about how you will move to make the W. 

 

Figure 4    

13. Write down the steps you would take to match the letter W. Use the words in Steps 4 and 9 as 

a pattern. 
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14. Have one person stand in the right place in front of the Motion Detector. Have another student 

click or tap Collect to start data collection, and then follow the directions you wrote in Step 13 

for making the letter W. 

15. If the graph of the W looks like the example, congratulations! If you want to try the W again, 

just click or tap Collect to start data collection, and follow the directions you wrote. 

Part II  “e-motion-al” graphs 

You have now made three letters with straight-line segments. Now let’s try expressing our  

“e-motions” by making a happy face and a sad face on the graph!  

16. You will now make a happy face. To get started, do the following things: 

a. Choose New from the File menu. 

b. On the Meter screen, tap Duration. Change the data-collection duration to 10 seconds. 

c. Click or tap the Graph tab. Choose Show Graph from the Graph menu and select Graph 1. 

This will display a graph of position vs. time. 

 

Figure 5  Happy face 

17. Write the steps you should follow to match the happy face graph shown in the example. Use 

the directions you wrote as a guide for what to write. 

  

  

  

  

  

18. Have one person stand in the right place in front of the Motion Detector, then have another 

student click or tap Collect to start data collection. Then, follow the directions you wrote in 

Step 17 for making the happy face. 

19. If the graph of the happy face matches the example, congratulations! If you want to try to 

make the happy face again, just click or tap Collect to start data collection and follow the 

directions you wrote. 
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20. You will now make a sad face. To get started, do the following things: 

a. Choose New from the File menu. 

b. On the Meter screen, tap Duration. Change the data-collection duration to 10 seconds. 

c. Tap the Graph tab. Choose Show Graph from the Graph menu and select Graph 1. This 

will display a graph of position vs. time. 

 

Figure 6  Sad face 

21. Write down what you need to do to match the sad face. 

  

  

  

  

  

 

22. Have one person stand in the right place in front of the Motion Detector, then have another 

student click or tap Collect to start data collection. When you hear fast clicking, follow the 

directions you wrote in Step 21 for making the sad face. 

23. If the graph of the sad face matches the sad face example, congratulations! If you want to try 

to make the sad face again, just start data collection, and follow the directions you wrote. 
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Exploring the Poles  
(Without Leaving Your Classroom!) 

Magnets have north and south poles. Do you think that the poles of differently shaped magnets are 

in different places? In this activity, you will use the Magnetic Field Sensor to find the poles of 

various magnets, make diagrams of them, and then see how the poles of one magnet make it 

behave with the poles of another magnet. 

OBJECTIVES 

 Make observations about the poles of differently shaped magnets. 

 Diagram the position of the poles of differently shaped magnets. 

 Draw conclusions about the poles of magnets. 

MATERIALS 

Chromebook, computer, or mobile device 

Graphical Analysis app 

Go Direct 3-Axis Magnetic Field Sensor 

several differently shaped magnets (bar, disk, horseshoe, cow magnet, etc.) 

paper and markers or crayons 

small stickers  

PROCEDURE 

Part I  Make a map of your magnets 

1. Set up the Magnetic Field Sensor for data collection:  

a. Launch Graphical Analysis. 

b. Connect the Magnetic Field Sensor to your Chromebook, computer, or mobile device.  

c. Find the dots near the end of the Magnetic Field Sensor. This is the part of the sensor that 

senses the magnetic field.  

d. Place the Magnetic Field Sensor on the table and tape the sensor in place. 
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2. Find the north and south poles of the magnet: 

a. Choose one of the magnets and trace its outline on a piece of paper. 

b. Pick up the magnet and look at the meter on the screen while you move one end of the 

magnet towards the Magnetic Field Sensor.  

 A positive number means the south pole of the magnet is close to the sensor. 

 A negative number means the north pole of the magnet is close to the sensor. (If a 

number is negative, it will have a minus sign (–) in front of it.) 

c. Label the south pole of the magnet with an “S” and the north pole of the magnet with an 

“N.” 

3. Repeat Step 2 to find the north and south poles on your other magnets.  

4. Record your observations on the Observations Sheet. 

Observations Sheet  

 

 

 

 

 

Part II  Find how the poles interact 

5. Find out how the poles of the different magnets interact with each other.  

a. Choose two of your magnets. Find the north pole of one magnet, and put it right next to the 

south pole of the other magnet. Write down what happens in the Data Table.  
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b. Now put the north pole of the first magnet near the north pole of the other magnet. Write 

down what happens in the Data Table. 

Data Table 

Position of the 

magnets 
What happens 

North near South   

North near North   

South near South   

6. Make a prediction about what will happen if you put the south pole of one magnet near the 

south pole of another magnet: 

Prediction 

I think the south poles of the two magnets will  

  
 

7. Now test your prediction. Write down what happens in the Data Table. 

ANALYZE YOUR DATA 

1. Write down what you have learned about magnets. 
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2. Look at the different tracings you made. Choose two of your magnets and tell about their 

shapes and where their poles are. 

  

  

  

 

3. Write a sentence that tells how the poles of magnets behave when the same (or like) poles are 

pushed together and when opposite (or different) poles are pushed together. 
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